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Matching SCE trainer packages for this Learn-/Training Document 

 
 

SIMATIC ET 200SP Distributed IO 
• SIMATIC ET 200SP Digital PROFINET 

Order no.: 6ES7155-6AU00-0AB0 
• SIMATIC ET 200SP Digital with input module ENERGY METER PN 
• Order no.: 6ES7155-6AU00-0AB1 
• SIMATIC ET 200SP Digital with communication module IO-LINK MASTER V1.1 PN 

Order no.: 6ES7155-6AU00-0AB2 
• SIMATIC ET 200SP Digital with communication module CM AS-i MASTER ST PN 

Order no.: 6ES7155-6AU00-0AB3 
• SIMATIC ET 200SP Safety expansion module 

Order no.: 6ES7136-6BA00-0AB1 
 
 

SIMATIC controllers 
• SIMATIC ET 200SP Open Controller CPU 1515SP PC2 F with WinCC RT Advanced 512 PTs 

Order no.: 6ES7677-2SB42-4AB1 

• SIMATIC ET 200SP Distributed Controller CPU 1512SP F-1 PN Safety 

Order no.: 6ES7512-1SK00-4AB2 

• SIMATIC CPU 1516F PN/DP Safety with software 

Order no.: 6ES7516-3FN00-4AB2 

 
 

SIMATIC STEP 7 Software for Training 
• SIMATIC STEP 7 Professional V15.1 - Single license 

Order no.: 6ES7822-1AA05-4YA5 
• SIMATIC STEP 7 Professional (V15.1) - Classroom license for 6 users  

Order no.: 6ES7822-1BA05-4YA5 
• SIMATIC STEP 7 Professional (V15.1) - Upgrade license for 6 users 

Order no.: 6ES7822-1AA05-4YE5 
• SIMATIC STEP 7 Professional V15.1 - Student license for 20 users 

Order no.: 6ES7822-1AC05-4YA5 
 

Note: 

– The SIMATIC STEP 7 Safety software for TIA Portal as of V15.1 is included in all the above-named "SIMATIC 

STEP 7 Software for Training" Trainer Packages. 

 

 

Please note that these trainer packages are replaced with successor packages when necessary.  

An overview of the currently available SCE packages is provided under: siemens.com/sce/tp 

 
 
 
 
 
 
 
 
 
 
 
 
 

http://www.siemens.com/sce/tp
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Training courses 
For regional Siemens SCE training courses, contact your regional SCE representative: 

siemens.com/sce/contact 

 

 

Additional information regarding SCE  
siemens.com/sce 

 

 
 

Information regarding use 
The SCE Learn-/Training Document for the integrated automation solution Totally Integrated Automation 

(TIA) was prepared for the program "Siemens Automation Cooperates with Education (SCE)" specifically 

for training purposes for public educational and R&D institutions. Siemens does not guarantee the contents. 

 

This document is only to be used for initial training on Siemens products/systems. This means it can be 

copied in whole or in part and given to trainees/students for use within the scope of their training/course of 

study. Disseminating or duplicating this document and sharing its content is permitted within public training 

and advanced training facilities for training purposes or as part of a course of study. 

 

Exceptions require written consent from Siemens. Send all related requests to 

scesupportfinder.i-ia@siemens.com. 

 

Offenders will be held liable. All rights including translation are reserved, particularly if a patent is granted 

or a utility model or design is registered. 

 

Use for industrial customer courses is expressly prohibited. We do not consent to commercial use of the 

training documents. 

 

We wish to thank the TU Dresden and the Michael Dziallas Engineering company and all other involved 

persons for the support in the preparation of this SCE Learn-/Training Document. 

 

http://www.siemens.com/contact
http://www.siemens.com/contact
http://www.siemens.com/sce
mailto:scesupportfinder.i-ia@siemens.com
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PROFIsafe and PROFINET with IO 
controller CPU 1516F-3 PN/DP and IO 
device ET 200SP 

1 Objective 

In this module, the reader will learn how to commission a safety-related application on PROFINET 

(PROFIsafe). The module uses the CPU 1516F-3 PN/DP on PROFINET as IO controller with an ET 

200SP as IO device to monitor the safety door on a sorting station. It also implements an EMERGENCY 

STOP using the ET 200S.  

The module shows the basic procedure using a simple example. 

The SIMATIC S7 controllers listed in chapter 3 can be used. 

2 Requirement 

This chapter builds on the chapter "Global data blocks for SIMATIC S7". 

To implement this chapter, you can use the following project, for example:  

"SCE_EN_032-600_Global_Data_Blocks…". 

3 Hardware and software required 

1 Engineering station: Hardware and operating system requirements apply  

(for additional information, see Readme on the TIA Portal Installation DVDs) 

 

2 SIMATIC STEP 7 Professional software in TIA Portal – as of V15.1 

 

3 Software STEP 7 Safety as of Basic V15.1 – already included in all the "SIMATIC STEP 7 Software 

for Training" Trainer Packages. 

4 SIMATIC S7-1500 controller with F-CPU, e.g. CPU 1516F-3 PN/DP – as of firmware V2.0 with 

memory card and 16DI/16DO 

 Note: The digital inputs should be fed out to a control panel. 

5 ET 200SP with fail-safe input/output modules for PROFIsafe with: 

– EMERGENCY STOP button, 2-channel 

– Safety door with 2 channels 

– Control of 2 main contactors of a load with feedback circuit 

– Acknowledgment button 

6 Ethernet connection between the engineering station and controller and between the controller and 

ET 200SP 
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2 SIMATIC STEP 7 
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3 STEP 7 Safety  

(TIA Portal) as of V15.1 

 

 

1 Engineering station 

6 Ethernet connection 

6 Ethernet connection 
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- EMERGENCY STOP button, 2-channel 

- Safety door with 2 channels 

- Control of 2 main contactors of a  

  load with feedback circuit 

- Acknowledgment button 

Control panel 

 
4 SIMATIC S7-1500 controller  

with F-CPU for PROFIsafe 
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4 Theory 

For further details, see the manuals at 

support.automation.siemens.com. 

 

4.1 Objective of safety engineering 

The objective of safety engineering is to keep potential hazards for both humans and the environment as 

low as possible without restricting, more than necessary, the production, the use of machines or the 

manufacture of specific products.  

Through guidelines that have been internationally harmonized to some extent, persons and the 

environment are to be protected equally in all countries. At the same time, unfair competition arising from 

different safety requirements in international trade is to be avoided.  

There are different concepts and requirements for ensuring safety in the various regions and countries of 

the world. The legal concepts and the requirements governing proof of adequate safety (when and how 

proof must be provided) are also different. The same applies to the allocation of responsibilities. For 

example, in the EU, there are requirements placed on both the manufacturer and the plant operator, 

which are set out by directives, laws and standards.  

On the other hand, in the US there are different requirements depending on the region or even the locale. 

However, throughout the USA there is a basic principle that an employer must guarantee a safe place of 

work. As a result of product liability laws, a manufacturer can be made liable for damage caused by its 

product.  

The important thing for machine manufacturers and constructors is that the laws and regulations in the 

country where the machine or plant is being operated always apply. For instance, the control system of 

a machine that is to be used in the EU must fulfill the EU requirements even if the machine manufacturer 

is headquartered in the US.  

http://support.automation.siemens.com/
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4.2 Safety concept of SIMATIC Safety Integrated in the TIA Portal 

The SIMATIC Safety Integrated fail-safe system is available in the TIA Portal for implementing safety 

concepts in the area of machine and operator protection. 

4.2.1 Principle of the safety functions in SIMATIC Safety Integrated 

The functional safety is achieved primarily through safety functions in the software.  

If a dangerous event occurs, safety functions are executed in order to bring the system to a safe state or 

to keep it in a safe state.  

The safety functions are mainly contained within the following components: 

– Safety-related user program of the F-CPU (z. B.: 1516F-3 PN/DP) 

– Fail-safe inputs and outputs of the F-IO (e.g.: ET 200SP). 

The F-IO ensures the safe processing of information from the field, such as information from 

– Sensors: EMERGENCY STOP buttons, safety doors, light barriers  

– Actuators: Motor control, valve blocks 

The user only programs the user safety function.  

In the event of a fault, if the F-system can no longer execute its actual user safety function, it executes 

the fault reaction function, for example, the associated outputs are disabled. 

 

4.2.2 Safety program 

You create a safety program in the program editor. You program fail-safe FBs and FCs in the FBD or 

LAD programming language with the instructions from the option package and create fail-safe DBs. 

When you compile the safety program, safety checks are automatically performed and additional fail-safe 

blocks for fault detection and fault reaction are incorporated. This ensures that failures and faults are 

detected, and appropriate reactions are triggered to maintain the F-system in a safe state or bring it to a 

safe state. 

Besides the safety program, a standard user program can also be run in the F-CPU. The co-existence of 

the standard program and safety program in an F-CPU is possible because the safety-related data of the 

safety program is protected from unwanted interference by data of the standard user program. 

Data exchange between the safety program and the standard user program in the F-CPU is possible 

using bit memory and data of a standard DB and by accessing the process image input and output. 
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4.2.3 Program structure of safety program in the TIA Portal 

Explanation Screen 

1. "Safety Administration" editor 

– Status of safety program 

– Collective F-signature 

– Safety mode status 

– Creating/organizing F-runtime groups 

– Information on the F-blocks 

– Information on F-compliant PLC data types 

– Defining/changing access protection 

 

2. User-created F-blocks 

3. System-generated F-runtime group blocks 

– Blocks contain status information about the 

F-runtime group. 

4. System-generated F-IO data blocks 

– Blocks contain tags for evaluation of the F-

modules. 

5. "Compiler blocks" - System-generated 

verification blocks 

– These run in the background of the 

controller and ensure the safety-related 

execution of the safety program. 

– These blocks cannot be manipulated by the 

user.  

 

4.2.4 Achievable safety requirements 

F-systems with SIMATIC Safety Integrated can meet the following safety requirements: 

– Safety class (Safety Integrity Level) SIL3 according to IEC 61508:2010 

– Performance Level (PL) e and Category 4 according to ISO 13849-1:2015 or EN ISO 13849-1:2015  
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4.3 STEP 7 Safety software (TIA Portal) as of V15.1 

The software package, which is included in all "SIMATIC STEP 7 Software for Training" Trainer 

Packages, contains all the functions and blocks required to create the F-program. 

The F-program with the safety functions is interconnected in F-FBD or F-LAD or with special function 

blocks from the F-library. Use of F-FBD or F-LAD simplifies the configuring and programming of the 

system as well as its acceptance thanks to uniform display for all systems. Programmers can fully 

concentrate on configuring of the safety-related application without having to use additional tools. 

4.3.1 Safety concept 

The safety functions of the S7-1500 F-CPUs are contained in the F-program of the CPU and in the fail-

safe signal modules. The fail-safe modules can be used in the ET 200 distributed IO systems.  

The fail-safe signal modules monitor output and input signals through discrepancy analyses and test 

signal injections. 

The CPU checks the proper operation of the controller through regular self-tests, command tests and 

logical and chronological program flow monitoring. In addition, the IO is checked through retrieval of 

signs-of-life. 

If a fault is diagnosed in the system, the system is brought to a safe state. 

An F-Runtime license is not required to operate the S7-1500 F-CPUs. 

Besides the fail-safe modules, standard modules can also be used. 

This makes it possible to establish a fully integrated control system for a system where safety-related and 

standard areas co-exist.  

The entire system is configured and programmed with the same standard tools. 

4.3.2 Programming 

The S7-1500 F-CPUs are programmed in the same manner as other SIMATIC S7 systems. The user 

program for non-fail-safe parts of the system is created with the proven programming tools of STEP 7 

Professional (TIA Portal) as of V15.1.  

The software package "STEP 7 Safety as of V15.1" is essential for programming the safety-related 

programs. It contains all the elements that are needed for engineering.  

The programming for the S7-1500 F-CPUs is done with the STEP 7 F-LAD or F-FBD language. Examples 

of safety functions that can be implemented here are: 

– User-programmable, safe linking of sensors with actuators 

– Selective safe shutdown of actuators 

The scope of functions with regard to operations and data types is restricted here.  

A safety-related, password-protected program is generated through a specific compilation setting. 

Besides the fail-safe program, a standard program can also run in parallel on a CPU (coexistence) with 

no restrictions.  
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An additional component of this software package is the F-library with off-the-shelf, programming 

examples for safety-related functions approved by the technical inspectorate. These programming 

examples can be adapted by the user; however, the changes must then be newly certified. 

4.4 SIMATIC S7-1500 automation system with F-CPU  

The SIMATIC S7-1500 automation system is a modular control system for the medium and high-

performance range. A comprehensive range of modules is available for optimal adaptation to the 

automation task with fail-safe and non-fail-safe CPUs and modules. 

Fail-safe F-CPUs for which safety-related user programs can be created are available for SIMATIC  

S7-1500. 

These F-CPUs support the safety-related PROFIsafe bus profile with PROFINET IO and PROFIBUS for 

communication between the safety program and the fail-safe modules of the F-IO. 

4.4.1 Example configuration of F-CPU 

The following configuration of an S7-1500 automation system with F-CPU is used for the program 

example in this document. 

 

①  Power module PM with input 120/230V AC, 50Hz / 60Hz, 190W and output 

24V DC / 8A 

② Central processing unit F-CPU 1516F-3 PN/DP with integrated PROFIBUS and PROFINET  

IO interfaces also for PROFIsafe 

③  IO module 32x digital input DI 32x24V DC HF 

④  IO module 32x digital output DQ 32x24V DC/0.5A HF 

⑤  IO module 8x analog input AI 8xU/I/RTD/TC ST 

⑥  IO module 4x analog output AQ 4xU/I ST 

  

① ② 

③ ④ ⑤ ⑥ 
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4.5 PROFIsafe bus profile with PROFINET IO 

The safety-related bus profile of PROFINET IO for communication between the safety program and the 

fail-safe modules of the F-IO is called PROFIsafe. 

4.5.1 Fail-safe modules 

Fail-safe modules (F-modules) are designed with two channels internally. This means that the two 

integrated processors monitor each other and automatically test the input or output connection. 

In the event of a fault, fail-safe modules are put into the safe state. 

The F-CPU communicates with the fail-safe modules via the safety-related PROFIsafe bus profile. 

4.5.2 PROFIsafe address 

The PROFIsafe address serves to protect standard addressing mechanisms such as e.g. IP addresses.  

The PROFIsafe address consists of the F-source address and F-destination address.  

4.5.3 PROFIsafe monitoring time 

The monitoring time for safety-related communication between the F-CPU and F-IO, together with 

additional measures, guarantees a maximum reaction time of the safety application. 
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4.6 SIMATIC ET 200SP Distributed IO 

SIMATIC ET 200SP is a modular distributed IO system for connecting fail-safe and non-fail-safe process 

signals to a central automation system such as SIMATIC S7-1500. Thanks to its comprehensive range of 

modules, ET 200SP can be modularly expanded for optimal adaptation to the automation task. 

Distributed IO are often used when signals must be transferred over long distances and the wiring effort 

for this is too great. Thus, the signals can be gathered locally and connected to a central controller via a 

bus system. In the case of the ET 200SP system, devices can be connected via PROFINET or 

PROFIBUS. 

The ET 200SP distributed IO is mounted on a standard mounting rail ⑦ and consists of an interface 

module ① with bus adapter ⑥, up to 32/64 IO modules ④ plugged onto BaseUnits ②, ③ and a 

terminating server module ⑤. 

  

The distributed IO provides inputs and outputs for the local process connection, which can be read and 

written by the central module via a bus protocol. The IO modules are queried and addressed in the S7 

program in the normal way using input addresses (%I) and output addresses (%Q), respectively. It is 

possible to mix fail-safe and non-fail-safe IO modules in an ET 200SP configuration. 

① 

④ 
② 
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4.6.1 Range of modules 

SIMATIC ET 200SP is a modular distributed IO system and offers the following range of modules: 

Interface modules with pluggable bus adapters 

for connection of distributed IO to a central module.  

Bus adapters enable users to use the connection system of their choice. Interface modules have their 

own power supply, which is not coupled via the backplane bus. 
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BaseUnits 

as universal base modules for electrical and mechanical connection of IO modules.  

They are available in a light version BU..D, which opens a new potential group over the backplane bus 

for the power supply, and a dark version BU..B, which continues the potential group. Thus, at least one 

light BaseUnit BU..D must be used in order to supply at least one potential group with voltage. The IO 

modules are plugged onto the BaseUnits. 

  

 

IO modules  

for digital input (DI) / digital output (DQ) / analog input (AI) / analog output (AQ).  

They are available in versions for 24V DC ① and 400V AC ②. 

 

 ① ② 
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F-IO modules  

For the connection of fail-safe signals, a digital input module F-DI 8x24VDC HF ① and the digital output 

modules F-DQ 4x24VDC/2A PM HF ② and F-RQ 1x24VDC/24.230VAC/5A ③, among others, are 

offered. 

   

 

You can find further details on the F-IO modules in manuals at  

support.automation.siemens.com. 

 

Communication modules (CM) 

For a point-to-point connection (PtP) ① or for connection to the IO-Link ② and AS-i ③ communication 

systems.  

  

  
① ② ③ 

① ② ③ 

http://support.automation.siemens.com/
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Server module 

As termination for the ET 200SP system configuration.  

It can be used as a holder for 3 standby fuses. It serves as a terminating resistor for the backplane bus 

and is thus required. 

 

4.6.2 Example configuration 

The following configuration of an ET 200SP distributed IO system is used for the program example in this 

learning/training document. 

 

① Interface module IM155-6PN HF with Bus Adapter BA 2xRJ45 

② IO module 4/8x fail-safe digital input F-DI 8x24V DC HF 

③ IO module 4x fail-safe digital output F-DQ 4x24V DC/2A PM HF 

④ IO module 8x digital input DI 8x24V DC HF 

⑤ Server module  

④ ⑤ ⑥ 

① ② ③ ④ ⑤ 
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4.7 Interface settings and reset for F-CPU and ET 200SP 

4.7.1 Setting the IP address in the CPU 

The IP address of the SIMATIC S7-1500 controller is set as follows. 

→ To do this, select the Totally Integrated Automation Portal, which is opened with a double-click.  

(→ TIA Portal V15.1)  

 

→ Select the → "Online & diagnostics" item and open the → "Project view". 
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→ In the project tree, select the network adapter that was set previously under → "Online access". When 

you click → "Update accessible devices", you see the IP address (if already set) or the MAC address 

(if the IP address has not yet been assigned) of the connected SIMATIC S7-1500. Select → "Online 

& diagnostics".  
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→ Under → "Functions", you will find the → "Assign IP address" item. Enter the following IP address 

and subnet mask, for example: → IP address: 192.168.0.1 → Subnet mask: 255.255.255.0. Click → 

"Assign IP address", and this new address will be assigned to your SIMATIC S7-1500.  

 

Note:  

– The IP address of the SIMATIC S7-1500 can also be set via the display on the CPU, if this is enabled 

in the hardware configuration. 

→ If the assignment of the IP address was not successful, you receive a message in the → "Info" window 

→ "General" tab. 

 



 Learn-/Training Document | TIA Portal Module 072-100, Edition 02/2021 | Digital Industries, FA 

For unrestricted use in educational and R&D institutions. © Siemens 2021. All rights reserved.  22 

sce-072-100-safety-pn-cpu1516f-et200sp-r2101-en.docx  

4.7.2 Formatting a memory card in the CPU 

→ If the IP address could not be assigned, the program data on the CPU must be deleted. This is done 

in 2 steps: → "Format memory card" and → "Reset to factory settings". 

→ First, select the → "Format memory card" function and click the → "Format" button. 

 

→ Confirm the prompt "Do you really want to format the memory card?" with → "Yes". 

 

→ Stop the CPU if necessary. (→ "Yes") 
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4.7.3 Resetting the CPU to factory settings 

→ Before you can finally reset the CPU memory, you must wait until the formatting of the CPU is finished. 

You must then select again → "Update accessible devices" and → "Online & diagnostics" of your 

CPU. To reset the controller, select the → "Reset to factory settings" function and click → "Reset". 

 

→ Confirm the prompt "Do you really want to reset the module?" with → "Yes".  

 

→ Stop the CPU if necessary. (→ "Yes") 
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4.7.4 Setting the IP address in the ET 200SP 

The IP address of the ET 200SP is set as follows. 

→ Select the Totally Integrated Automation Portal and open it with a double-click. (→ TIA Portal V15.1)  

 

→ Select the → "Online & diagnostics" item and open the → "Project view". 
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→ In the project tree, select the network adapter that was set previously under → "Online access". When 

you click → "Update accessible devices", you see the IP address (if already set) or the MAC address 

(if the IP address has not yet been assigned) of the connected ET 200SP. Select → "Online & 

diagnostics".  
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→ Under → "Functions", you will find the → "Assign IP address" item. Enter the following IP address 

and subnet mask, for example: → IP address: 192.168.0.2 → Subnet mask: 255.255.255.0. Click → 

"Assign IP address", and this new address will be assigned to your ET 200SP.  

 

→ You receive feedback regarding the assignment of the IP address as a message in the → "Info" 

window → "General" tab. 

 

Note:  

– If a communication connection already exists between the ET 200SP as device and a higher-level 

controller as controller, the IP address cannot be changed. 
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4.7.5 Reading out the firmware version of the ET 200SP  

→ Before you can read out the firmware version of the ET 200SP, you must again select → "Update 

accessible devices" and → "Online & diagnostics" of your ET 200SP. In the menu item → 

"Diagnostics" → "General", you can read out the short description, article number, hardware version 

and firmware version. 
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5 Task 

In the following, a safety application is to be added to the project from chapter  

"SCE_EN_032-600_Global_Data_Blocks". 

The safety of the operators of a sorting station will be ensured by blocking access by a guard with safety 

door. In addition, an EMERGENCY STOP will be incorporated that can be used to stop the station in an 

emergency. 

6 Planning 

The signals for the safety engineering are connected to a distributed ET 200SP IO device, which is 

assigned as a device to the CPU 1516F-3 PN/DP via PROFINET. 

The safety program safely switches off all loads of the sorting station if: 

– A safety door monitored by two contacts is opened or 

– An EMERGENCY STOP connected via two channels is actuated. 

After actuation of the EMERGENCY STOP or opening of the safety door, a local user acknowledgment 

is necessary before the production operation can be restarted. 

This is implemented by programming a fail-safe block with  

• A safety door function,  

• an EMERGENCY STOP function (safety circuit for shutdown when EMERGENCY STOP is 

actuated and when safety door is opened), 

• A feedback circuit (as a restart protection in case of a faulty load) and  

• A user acknowledgment for the re-integration  

and generating a safety program. 

6.1 Connection of the F-modules 

For the EMERGENCY STOP, a two-channel sensor is connected to the two inputs DI0 and DI1 of the F-

module. The evaluation of the sensors must be set to 1oo2 (2v2) evaluation for this. 

A cross circuit of the inputs is also checked through the internal sensor supply of the sensors from two 

different sensor supplies. 
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For the safety door, two sensors are connected via 1 channel to DI1 and DI5 of the F-module. The 

evaluation of the sensors must be set to 1oo1 (1v1) evaluation for this. 

A cross circuit of the inputs is also checked through the internal sensor supply of the sensors from two 

different sensor supplies. 

 

 

For control of the main contactors of the load, 2 relays are connected in parallel to the DQ0 of the F-

module. The feedback circuit of the main contactors is connected to a non-fail-safe input channel. 

 

 

Note:  

– You can find further information in the manuals for the ET 200SP and the fail-safe modules.  
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6.2 Reference table 

The following signals are required as global operands for this safety-related program expansion. 

DI Type Identifier Function NC/NO 

I 200.0 BOOL -S10_EMERG_STOP Emergency stop 2-channel (F) NC 

I 200.1 BOOL -S11.1_DOOR_CONTACT_1 First door contact (F) NC 

I 200.5 BOOL -S11.2_DOOR_CONTACT_2 Second door contact (F) NC 

I 20.1 BOOL -K20_FEEDBACK_LOOP 
Feedback loop  

main load contactors 
NC 

I 20.0 BOOL -S12_ACKNOWLEDGE Push-button acknowledge NO 

I 201.1 BOOL -S11.1_DOOR_CONTACT_1_VS 
Value status (0==substitute value) 

First door contact 
NC 

I 201.5 BOOL -S11.2_DOOR_CONTACT_2_VS 
Value status (0==substitute value) 

Second door contact 
NC 

I 210.0 BOOL -K20_LOAD_CONTACTOR_VS 
Value status (0==substitute value) 

main load contactors 
NC 

 

DO Type Identifier Function  

Q 210.0 BOOL -K20_LOAD_CONTACTOR Control main load contactors (F)  

 

Legend for reference list 

 

 

 

 

 

 

 

 

DO Digital Output 

AO Analog Output 

Q Output 

F Failsafe Signal 

DI Digital Input 

AI Analog Input 

I Input 

NC Normally Closed  

NO Normally Open  
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7 Structured step-by-step instructions 

You can find instructions on how to perform planning below. If you already have a good understanding of 

everything, it is enough to focus on the numbered steps. Otherwise, simply follow the steps of the 

instructions illustrated below. 

7.1 Retrieving an existing project 

→ Before we can extend the project "sce-032-600-global-data-blocks…" from chapter "sce-032-600-

global-data-blocks", we have to retrieve it. To retrieve an existing project, you must select the 

respective archive from the Project view under → Project → Retrieve. Confirm your selection with 

Open. (→ Project → Retrieve → selection of a .zap archive → Open) 

 

→ Next, the target directory in which the retrieved project is to be stored can be selected. Confirm your 

selection with "OK". (→ Target directory → OK) 
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→ Save the opened project under the name "072-100_SAFETY PN CPU1516F and ET200SP"  

(→ Project → Save as … → 072-100_SAFETY PN CPU1516F and ET200SP → Save). 
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7.2 Activating the safety setting for the CPU 1516F-3 PN/DP 

→ First, it should be checked whether the "Generate default fail-safe program" check box has been 

selected under "STEP 7 Safety" in the "Options" menu. (→ Options → Settings → STEP 7 Safety → 

Generate default fail-safe program) 

 

 

Note:  

– As a result of this setting, when a fail-safe CPU is used, the fail-safe support is enabled in the TIA 

Portal and a safety program is automatically created. If a fail-safe CPU without safety functions is to 

be used, the "Generate default fail-safe program" check box must be cleared before using the F-CPU.  
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→ Open the "Device configuration" of the "CPU 1516F-3 PN/DP". Double-click the CPU to select it, and 

in the → "Properties" window, open menu → "Fail-safe" → "F-activation". There select → "Enable F-

activation". (→ Enable F-activation) 

 

→ Now, "F-capability activated" is displayed and the subitem "  Safety Administration" appears in the 

project tree. 
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→ In menu → "Fail-safe" → "F-parameters", the ranges for the "F-addresses" and the "Default F-

monitoring time for central F-IO" are now set. (→ Fail-safe → F-parameters → Low limit for F-

destination addresses: 1 → High limit for F-destination addresses: 99 → Central F-source address: 

1 → Default F-monitoring time for central IO: 150 ms) 

 

Note:  

– The safety-relevant "F-monitoring time" setting should be coordinated with the requirements from the 

risk assessment of the plant. This also applies to the other safety-relevant settings in this document. 
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→ Go to the → "Protection & Security" menu and select → "Access level" → "Full access incl. fail-safe 

(no protection)". 

 

Note:  

– The "Full access incl. fail-safe (no protection)" setting has been selected here because a password 

will be assigned later for the safety program and then only a password has to be assigned. 
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7.3 Configuration of ET 200SP/IM 155-6PN HF 

→ Now open the network view. Find the correct interface module IM155-6PN HF from the hardware 

catalog and insert it into the network view using drag-and-drop. (→ Network view → Hardware catalog 

→ Distributed IO → ET 200SP → Interface module → PROFINET → IM155-6 PN HF → 6ES7 155-

6AU00-0CN0 → Version: V3.3)  

 

→ Assign the field device to the CPU 1516F by first clicking on the interface of the IM155-6PN HF in the 

network view and then connecting it to the PROFINET interface (X1) of the CPU 1516F. 
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→ To configure the IM155-6PN HF, first select the IO device. In the → "General" tab in the → 

"Properties" window, open the → "Ethernet addresses" menu → and set the IP address under → "IP 

protocol". (→ IO device_1 → Properties → General → Ethernet addresses → IP protocol → IP 

address: 192.168.0.2) 

 

→ Click on the name → "IO-device 1" and change it to → "IO-Safety". 

 

Note:  

– This name is now also applied as the device name for the PROFINET communication. 
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→ In the → "Ethernet addresses" → menu, the "PROFINET device name" and the "Diagnostics 

address", which is automatically assigned for the diagnostics", can be checked under → 

"PROFINET". (→ Ethernet addresses → PROFINET → PROFINET device name: io-safety → 

Diagnostics address: 1) 
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→ Settings for the "IO cycle" such as the "Update time" and 'Watchdog time" can also be set for the 

device here. (→ Advanced options → Real time settings → IO cycle → Update time → 1,000 ms → 

Watchdog time → 3,000 ms) 

 

Note:  

– The watchdog time should always be significantly shorter than the F-monitoring time set beforehand. 
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→ To obtain an overview of the assigned addresses within a project, you can click the " " button in 

the "Network view". (→ Network view →  Display addresses)  

 

→ Change to the device view of the ET 200SP by double-clicking on the PROFINET device. (→ IO-

Safety) 

 
 

Note:  

– You can also open the device view of the various devices in the drop-down menu at the top left of the 

device view. 
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→ Find the correct digital fail-safe input module with matching order number and version in the hardware 

catalog. Insert the digital F-input module on slot 1. (→ Hardware catalog → DI → F-DI 8x24VDC HF 

→ 6ES7 136-6BA00-0CA0 → Version: V1.0) 
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→ The settings for the fail-safe input module "F-DI 8x24VDC HF" must still be made in the properties. 

First, the IO addresses are set to "Start address: 200". (→ IO addresses → Start address: 200). 

 

→ For the general "F-parameters", the "F-destination address" and the "Behavior after channel fault" 

are entered (→ F-parameters → F-destination address: 65534 → Behavior after channel fault: 

Passivate channel). 
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→ Activate the "short-circuit test" for the "Sensor supplies" 0/1/4/5.  
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For the EMERGENCY STOP, a two-channel sensor is connected to the two inputs DI0 and DI1 of the F-

module. The evaluation of the sensors must be set to 1oo2 (2v2) evaluation for this. 

A cross circuit of the inputs is also checked through the internal sensor supply of the sensors from two 

different sensor supplies. 

 

You can find further information in the manuals for the ET 200SP and the fail-safe modules.  

→ The following DI parameters are to be set for the EMERGENCY STOP that is wired to "Channel 0, 

4". (→ DI parameters → Channel parameters → Channel 0, 4) 

 

Note:  

– Through the selected sensor evaluation, the two inputs DI0 and DI4 are combined into one input 

signal for the EMERGENCY STOP. The EMERGENCY STOP thus receives the address "%I200.0". 
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For the safety door, two sensors are connected via 1 channel to DI1 and DI5 of the F-module. The 

evaluation of the sensors must be set to 1oo1 evaluation for this. 

A cross circuit of the inputs is also checked through the internal sensor supply of the sensors from two 

different sensor supplies. 

 

You can find further information in the manuals for the ET 200SP and the fail-safe modules.  

 

→ The following DI parameters are to be set for the two safety door contacts that are wired to "Channel 

1, 5". (→ DI parameters → Channel parameters → Channel 1, 5) 

 

Note:  

– Through the selected sensor evaluation, the two inputs DI1 and DI5 are designated separately for the 

safety door contacts. They thus receive the addresses "%I200.1" and "%I200.5".  
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→ Channels 2 and 6 are not needed and are therefore deactivated in the DI parameters.  

(→ DI parameters → Channel parameters → Channel 2, 6) 

 

→ Channels 3 and 7 are also deactivated in the (→ DI parameters → Channel parameters → Channel 

3, 7) 
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→ Find the correct digital fail-safe output module, with matching order number and version from the 

hardware catalog. Insert the digital F-output module on slot 2. (→ Hardware catalog → DQ → F-DQ 

4x24VDC/2A PM HF → 6ES7 136-6DB00-0CA0 → Version: V1.0) 
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→ The settings for the fail-safe output module "F-DQ 4x24VDC/2A PM HF" must still be made in the 

properties. First, the IO addresses are set to "Start address: 210". (→ IO addresses → Start address: 

210) 

 

→ For the general "F-parameters", the "F-destination address" and the "Behavior after channel fault" 

are entered (→ F-parameters → F-destination address: 65533 → Behavior after channel fault: 

Passivate channel). 
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For control of the main contactors of the load, 2 relays are connected in parallel to the DQ0 of the  

F-module. 

 

You can find further information in the manuals for the ET 200SP and the fail-safe modules.  

→ The following DQ parameters are to be set for the control of the main contactors of the load that are 

wired to "Channel 0". Channels 1,2,3 are not wired and are therefore deactivated. (→ DQ parameters 

→ Channel 0 → Channel 1 → Channel 2 → Channel 3) 

 

Note:  

– The output to the contactors of the load thus has address "%Q210.0". 

 

Note:  

– For each F-IO module, an associated F-IO data block is also generated for the system blocks. The 

designation results from the name and address of the F-IO module.  
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→ Next, find the correct digital input module with matching order number and version in the hardware 

catalog and insert it on slot 3. (→ Hardware catalog → DI → DI 8x24VDC HF → 6ES7 136-6BF00-

0CA0 → Version: V2.0) 

 

→ In the properties, the input addresses must be set to "Start address: 20". (→ IO addresses → Start 

address: 20) 
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7.4 Changing components in the hardware configuration 

→ If it is necessary to replace a component in the hardware configuration with a newer version or a 

different type, this can be done by right clicking the component and then selecting "Change device". 

A dialog then opens where you can select a new component for the replacement and confirm the 

selection with "OK". (→ Change device → OK) 

 

 

Note:  

– If the new component is not displayed for selection, it is not compatible with the previous component. 

In this case, the old component must be deleted first, and the new component must then be inserted 

from the hardware catalog.  
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7.5 Inserting the server module 

→ Find the correct server module with matching order number and version in the hardware catalog. 

Insert the server module in slot 5.  (→ Hardware catalog → Server module → 6ES7 193-6PA00-0AA0 

→ Version: V1.1) 

 

 

Note:  

– If you forget to insert the server module, it will be created automatically when the device configuration 

is compiled. 
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7.6 Configuration of the potential groups of the BaseUnits 

→ To change the potential group of a BaseUnit, select the associated module and open the "Potential 

group" section in the general properties. Select the "Enable new potential group (light BaseUnit)" 

option. (Slot 3 → Properties → General → Potential group → Enable new potential group (light 

BaseUnit)) 
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→ The BaseUnit in the configuration has now become a light BaseUnit. Repeat these steps for slot 2 

and compare the device configuration with the figure below. 

→ Save your project by clicking the →  button, and select menu item → "  Safety 

Administration" with a double-click in order to create and edit the F-runtime group there. 

 

 

→ In "Safety Administration", select menu item "F-runtime group" and click on "Add new F-runtime 

group". (→ F-runtime group → Add new F-runtime group) 
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→ You can then assign a name for an F-runtime group as shown here. You can also have the fail-safe 

organization block "FOB_RTG1" created with the suitable "Cycle time" for the safety application. 

Likewise, the Main safety block "Main_Safety_RTG1" and the associated data block 

"Main_Safety_RTG1_DB" will also be created there. (→ FOB_RTG1 → Cycle time 100ms → 

Main_Safety_RTG1 → Main_Safety_RTG1_DB → OK) 
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→ Before you compile the configuration, you should save your project again by clicking the → 

 button. To compile your CPU with the device configuration, first select the → 

"CPU_1516F [CPU1516F-3 PN/DP]" folder and click the → "Compile" button .  

 

Note: 

– You should use the "Save project" function periodically when working on a project because automatic 

saving of the project does not occur. The only time you are prompted to save the project is when you 

close the TIA Portal. 

→ If the configuration is compiled without errors, you see the following: 

 

Note:  

– Warnings appear here because no protection level has been configured and the fail-safe inputs and 

outputs are not yet being used in the program. The warnings can be ignored.  
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7.7 Assigning the device name to interface module IM 155-6PN HF 

→ To obtain an overview of the assigned IP addresses within a project, you can click the " " button in 

the "Network view". (→ Network view →  Display addresses)  

 

 

→ So that the controller, here the CPU1516F-3 PN/DP, can find the assigned PROFINET devices in the 

network, they must be assigned device names. This is done by selecting the network in the "Network 

view", which connects the devices, and then clicking on the " " button. (→  Assign device name) 

 

Note:  

– The IP addresses set in the project are assigned by the controller to the devices later during 

establishment of the communication connection. 
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→ The online access must be correctly set in the dialog for assignment of the PROFINET device names. 

Then, each device can be individually selected and filtered by devices of the same type. If a new 

device is connected first, the list must be updated again. (→ PROFINET device name: io-safety → 

Type of the PG/PC interface: PN/IE → PG/PC interface: here: Intel(R) Ethernet Connection (4)I219-

LM →  Only show devices of the same type → ) 
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→ The correct device must be unambiguously determined based on the MAC address printed on the 

device before the name is assigned with " ". You can also have the LEDs flash on 

the device for checking purposes. (→  → ) 

 

→ The successful assignment of the PROFINET device name should still be checked before the dialog 

is closed. (→ ) 
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7.8 Downloading the hardware configuration to the device  

→ To download your complete CPU, select the → "CPU_1516F [CPU1516F-3 PN/DP]" folder again and 

click the → "Download to device" button .  

 

 

→ The manager for configuration of connection properties (Extended download) opens. First, the 

interface must be correctly selected here. This is done in three steps. 

– Type of the PG/PC interface → PN/IE 

– PG/PC interface → here: Intel(R) Ethernet Connection (4)I219-LM 

– Connection to interface/subnet → "PN/IE_1" 

→ The → "Show all compatible devices" field must then be selected and the search for devices in the 

network must be started by clicking the →  button. 
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→ If your CPU is displayed in the "Compatible devices in target subnet" list, select it and start the 

download. (→ CPU 1516F-3 PN/DP → "Load") 

 

→ You first receive a preview. Confirm the control window → "Consistent download" and continue with 

→ "Load". 
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Note:  

– In the "Load preview", you should see the " " symbol in each line. You can see additional information 

in the "Message" column. 

→ The → "Start module" option is now selected before the download operation can be completed with 

→ "Finish". 
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→ The project view is opened again automatically after a successful download operation. A download 

report appears in the "General" tab of the Info window. This can be helpful for troubleshooting if the 

download operation was unsuccessful. 

 

7.9 Assigning the PROFIsafe addresses 

→ Finally, the PROFIsafe addresses must still be assigned in the safety modules of the ET 200SP. To 

do so, right-click on the ET 200SP as shown here and select → "  Assign PROFIsafe address". (→ 

 Assign PROFIsafe address) 
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→ The interface for online access can be selected in the following dialog. This is done in three steps. 

– Type of the PG/PC interface → PN/IE 

– PG/PC interface → here: Intel(R) Ethernet Connection (4)I219-LM 

– Connection to interface/subnet → "PN/IE_1" 

→ Select the two modules "F-DI 8x24VDC HF_1" and "F-DQ 4x24VDC/2A PM HF_1" by setting the "

" in the "Assign" column. Select "Identification " " by LED flashing" and click on the 

"Identification" button. (→ Assign  → Assign  → Identification  by LED flashing → 

Identification) 
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→ Confirm the flashing of the LEDs on the two modules "F-DI 8x24VDC HF_1" and "F-DQ 4x24VDC/2A 

PM HF_1" by setting the " " in the "Confirm" column. Then click on the "Assign PROFIsafe address" 

button. (→ Confirm  → Confirm  → Assign PROFIsafe address) 

 

 

→ Confirm the assignment of the PROFIsafe address within 55 seconds by clicking the → "Yes" button. 

(→ Yes) 
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→ Close the dialog window for assigning the PROFIsafe address. (→ Close) 

 

Note:  

– For the ET 200SP, the PROFIsafe addresses are stored in the small white coding plugs of the F-

modules. 
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7.10 Creating and downloading the safety program 

According to the task, a safety-related shutdown of a plant as a consumer is to be performed in the 

following safety program if: 

– A safety door monitored by two contacts is opened or 

– An EMERGENCY STOP connected via two channels is actuated. 

After actuation of the EMERGENCY STOP or opening of the safety door, a local user acknowledgment 

is necessary before the production operation can be restarted. 

In our example, a fail-safe block with a safety door function, an EMERGENCY STOP function (safety 

circuit for shutdown when EMERGENCY STOP is actuated and when safety door is opened), a feedback 

circuit (as restart protection in case of faulty load) and a user acknowledgment for the re-integration is to 

be programmed and generated to form a safety program. 

The prerequisite for the programming is a correctly created hardware configuration as was previously 

described. 

 

F-IO data blocks 

For each F-IO, an "F-IO DB" is automatically generated in the hardware configuration during  

compilation and a symbolic name for it is simultaneously entered in the symbol table. You can see the F-

IO DBs generated for the example IO in the block container. 

The symbolic name of the F-IO DB is formed from the fixed prefix "F", the start address of the F-IO and 

the name entered in the device configuration for the F-IO.  
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→ First, the global PLC tags must be specified for the safety program. To do this, select the "CPU_1516F 

[CPU 3156F-3 PN/DP]" in the project tree and create a new "Tag_table_safety" under "PLC tags". 

Open the "Tag table_safety" with a double-click and enter the "Name", "Data type", "Address" and 

"Comment" for the inputs and outputs of the safety program. (→ CPU_1516F [CPU 3156F-3 PN/DP] 

→ PLC tags → Tag table_safety) 

 

 

Note:  

– The value status tags are available in the F-modules of the ET 200SP to obtain diagnostic information 

on the value status of individual channels. The F-IO DBs have only a QBAD tag that indicates the 

status of the overall module. 
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→ Open the "Main_Safety_RTG1" block in the Program blocks folder and change the programming 

language to FBD in the Properties window under General. (→ CPU_1516F [CPU 3156F-3 PN/DP] → 

Program blocks → Main_Safety_RTG1 → Properties General → FBD) 
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The safety program for our plant will now be created in the "Main_Safety_RTG1" block. Additional blocks 

will be called from the safety functions for this purpose. Additionally, created local (and thus fail-safe) tags 

will be used to interconnect the blocks. 

Only the 'Bool', 'DInt', 'DWord', 'Int', 'Time' and 'Word' data types are permitted in the safety program. 

→ Create the static tag "Release_safety_door" with the "Bool" data type. (→ Static → 

Release_safety_door → Bool) 
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→ Enter here, as well as in the other steps, the block title and network heading for Network 1. Using 

drag-and-drop, move the block for the safety door monitoring "SFDOOR" from the safety functions to 

the first network of the "Main_Safety_RTG1" block. (→ SFDOOR) 

 

 

→ For the call option, select 'Multi-instance' and confirm with 'OK' (→ Multi-instance → OK) 
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→ A safety door function is programmed with the help of "SFDOOR". Inputs "IN1" and "IN2" are 

interconnected with the door contacts "QBAD_IN1" and "QBAD_IN2" are used to query the fault-free 

function of the utilized channels of the F-IO. With "OPEN_NEC = TRUE", a check of the safety device 

(fully open door and close again) is required after a restart of the safety program. "ACK_NEC = TRUE" 

means that a user acknowledgment is required after the safety door has been opened. The signal of 

the user acknowledgment is interconnected at the "ACK" input. The "Release_safety_door" occurs 

at output "Q" when the safety door is in the safely closed state. 
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→ The release of the safety circuit is programmed in the second step. Additional static tags must first 

be created for this, as shown here. The EMERGENCY STOP signal can be directly interconnected 

because safe functioning of the "EMERGENCY STOP" is already provided due to the settings in the 

device configuration of the F-IO. 
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→ The feedback monitoring is configured using the "FDBACK" block in the third network. 

To do so, drag the block for the feedback circuit monitoring "FDBACK" from the safety functions to 

the third network of the "Main_Safety_RTG1" block.(→ FDBACK) 

 

→ For the call option, select 'Multi-instance' and confirm with 'OK'. (→ Multi-instance → OK) 
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→ The feedback monitoring is configured using the "FDBACK" block in the third network. 

The "ON" input is connected together with the release of the safety circuit by the switch-on signal "-

K0" "main switch ON" (no). As long as a 1 signal is present, the "Q" output to the load is activated. 

The signal at the "FEEDBACK" input must fall from 1 to 0 within the set "FDB_TIME" time. 

Otherwise, the "Q" output will be disabled again, and a block fault occurs. A fault can be 

acknowledged with the user acknowledgment at input "ACK". "QBAD_FIO" is used to query the 

fault-free function of the utilized channel of the F-IO. 
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→ The depassivation of the F-IO is configured using the ACK_GL in the fourth network.  

To do so, drag the block for the global acknowledgment of all F-IO of a runtime group "ACK_GL" 

from the safety functions to the fourth network of the "Main_Safety_RTG1" block. (→ ACK_GL) 

 

→ For the call option, select 'Multi-instance' and confirm with 'OK' (→ Multi-instance → OK) 
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→ The "ACK_GL" serves the global acknowledgment of all F-IO of a runtime group and thus the 

depassivation of the F-IO. With the user acknowledgment at input "ACK_GLOB", a global 

acknowledgment of all F-IO can be performed. 

 

 

→ Before you download the safety program, however, you should save your project again by clicking 

the →  button. To download the safety program, select the → "CPU_1516F 

[CPU1516F-3 PN/DP]" folder again and click the → "Download to device" button .  
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→ You first receive a preview. Continue with → "Load". 

 

Note:  

– In the "Load preview", you should see the " " symbol in each line. You can see additional information 

in the "Message" column. 

→ The → "Start module" option is now selected before the download operation can be completed with 

→ "Finish". 
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→ By clicking on the "  Monitoring On/Off" button, you can monitor the state of the input and output 

tags at the "Main_Safety_RTG1" block when testing the program. (→ ) 
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→ However, a warning is still displayed at menu item "  Safety Administration". To eliminate this, the 

online connection must first be disconnected. Then you open → "  Safety Administration" with a 

double-click. (→  →  Safety Administration) 
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→ Here, access protection must be activated for the safety program. Click on "Setup" under "Access 

protection" and assign the password "pw_fprog" for the safety program. (→ Access protection → 

Setup → pw_fprog → pw_fprog → OK) 

 

→ You can log off from the safety program in the Access protection menu or by right clicking the  

" " symbol next to  "Safety Administration". However, this should not be done until later. 
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→ Activate the options indicated here in the settings for the safety program. (→  Activation of F-

change history →  Enable consistent upload from the F-CPU) 

 

→ Save your project again and download the changes to the controller.  

(→  → ). 
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→ You first receive a preview where you must select stopping of the CPU. Continue with → "Load". 

 

Note:  

– Changes to the safety program can only be loaded consistently when the CPU is in STOP state. 

→ Now, the → "Start all" option is selected before the download operation can be completed with → 

"Finish". 
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7.11 Diagnostics functions for the safety program  

→ The status of the collective F-signature can be displayed in "General" under "Safety Administration". 

For acceptance of a system, this signature must be identical online and offline and must be 

documented. 

 

→ The status of the individual block signatures can be displayed in "F-blocks" under "Safety 

Administration". This can be helpful for finding out where changes have been made. 
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→ Now, log off from the safety program. (→ Log off from offline safety program) 

 

→ The fail-safe block "Main_Safety_RTG1" can still be monitored, nevertheless.  

(→ ). 
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→ The diagnostics data for the "SFDOOR" and "FDBACK" blocks called in the "Main_Safety_RTG1" 

block can be monitored via the multi-instances in the "Main_Safety_RTG1_DB" instance data block. 

 

→ In the "RTG1SysInfo" data block you obtain information on the collective F-signature, generation date, 

cycle time of runtime group, version of STEP 7 Safety, etc. 
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→ You obtain diagnostic information for the F-modules in the usual way by right-clicking on the module 

and selecting "Online & diagnostics". 

 

 

→ You also obtain information on the state of the F-modules in the F-IO DBs. 
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→ Finally, disconnect the online connection (→ ) 
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7.12 Archiving the project 

→ To archive the project, select the → "Archive…" command in the → "Project" menu. 

 

 

→ Select a folder in which you want to archive your project and save the project. ( → sce-072-100-

safety-pn-cpu1516f-et200sp… → Archive) 
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7.13 Checklist – step-by-step instructions 

The following checklist helps trainees/students to independently check whether all steps of the step-by-

step instruction have been carefully completed and enables them to successfully complete the module 

on their own. 

No. Description Checked 

1 Safety settings for the CPU 1516F-3 PN/DP activated.  

2 ET 200SP with IM 155-6PN HF configured.  

3 Device name of the ET 200SP assigned.   

4 Hardware configuration downloaded to the CPU1516F-3 PN/DP.  

5 
PROFIsafe addresses assigned to the safety modules of the ET 

200SP. 
 

6 Safety program created and downloaded.  

7 
Program blocks successfully compiled and downloaded without 

error message. CPU is in RUN. 
 

8 

Open the safety door 

-S11.1_DOOR_CONTACT_1 = 0 

-S11.2_DOOR_CONTACT_2 = 0 

 

9 

Close safety door and acknowledge 

-S11.1_DOOR_CONTACT_1 = 1 

-S11.2_DOOR_CONTACT_2 = 1 

-S12_ACKNOWLEDGE = 1 

 

10 

Release EMERGENCY STOP and acknowledge 

-S10_EMERG_STOP = 1 

-S12_Acknowledge = 1 

 

11 

Signal feedback circuit at 1  

-K20_FEEDBACK_LOOP = 1 

Switch on system 

-K0 (main switch "ON") = 1 

The main load contactors are then switched on 

-K20_LOAD_CONTACTOR = 1 

 

12 
The signal feedback circuit changes to 0 within 1 second 

-K20_FEEDBACK_LOOP = 0 
 

13 Project archived successfully.  
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8 Exercise 

8.1 Task – Exercise  

Program the two displays "-P4" (display "EMERGENCY STOP activated") and "-P8" (display 

"Acknowledgment requested") in a "SAFETY_DIAGNOSTICS" function and call them in organization 

block "Main".  

In so doing, the display "-P4" (display "EMERGENCY STOP activated") is to light up when no safe release 

exists for switching on the main contractor for the load. 

The display "-P8" (display "Acknowledgment requested") is always to light up when the "-

S12_Acknowledge" button is to be actuated for acknowledging an error in the safety program or an error 

in the F-modules.  

This is possible by programming within the "SAFETY_DIAGNOSTICS" function with access to the fail-

safe inputs and outputs and to the fail-safe data blocks. 

At the block call of „MOTOR_AUTO[FB1]“ the Signal „-A1“ should be replaced by the release of the safety 

circuit. 

DO Type Identifier Function  

Q 1.0 BOOL -P4 Display "Emergency Stop activated"  

Q 1.4 BOOL -P8 Display "Acknowledgment requested"  

 

8.2 Planning 

Plan the implementation of the task by yourself. 
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8.3 Checklist – Exercise 

The following checklist helps trainees/students to independently check whether all steps of the exercise 

have been carefully completed and enables them to successfully complete the module on their own. 

No. Description Checked 

1 
Function "SAFETY_DIAGNOSTICS" created. 

Call and changes in OB1 completed.  
 

2 
Program blocks successfully compiled and downloaded without 

error message. 
 

3 

Open the safety door 

-S11.1_DOOR_CONTACT_1 = 0 

-S11.2_DOOR_CONTACT_2 = 0 

or 

Actuate EMERGENCY STOP 

-S10_EMERG_STOP = 0 

 

-P4 (display "Emergency Stop activated") = 1 

 

4 

Open the safety door 

-S11.1_DOOR_CONTACT_1 = 0 

-S11.2_DOOR_CONTACT_2 = 0 

Close the safety door again 

-S11.1_DOOR_CONTACT_1 = 1 

-S11.2_DOOR_CONTACT_2 = 1 

Safety door opened and closed again 

-P8 (display "Emergency Stop activated") = 1 

 

5 

Actuate EMERGENCY STOP 

-S10_EMERG_STOP = 0 

Release EMERGENCY STOP 

-S10_EMERG_STOP = 1 

EMERGENCY STOP actuated and released again 

-P8 (display "Acknowledgment requested") =1 

 

6 
Fault in feedback circuit occurred and eliminated again 

-P8 (display "Acknowledgment requested") =1 
 

7 

Fault in input module  

F-DI8x24VDCHF_1 occurred and eliminated again 

-P8 (display "Acknowledgment requested") =1 

 

8 

Fault in fail-safe output module  

F-DQ4x24VDC/2APMHF_1 occurred and eliminated again 

-P8 (display "Acknowledgment requested") =1 

 

13 Project archived successfully.  
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9 Additional information 

You can find additional information as an orientation aid to familiarize yourself or deepen your knowledge, 

for example: Getting Started, videos, tutorials, apps, manuals, programming guidelines and trial software/ 

firmware, under the following link:   

 

siemens.com/sce/safety 

 

"Additional information" preview –→ in preparation 

 

 

 

 

 

 

http://www.siemens.com/sce/safety
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Additional information 

Siemens Automation Cooperates with Education 

siemens.com/sce 

SCE Learn-/Training Document 

siemens.com/sce/module 

SCE Trainer Packages 

siemens.com/sce/tp 

SCE Contact Partners  

siemens.com/sce/contact 

Digital Enterprise 

siemens.com/digital-enterprise 

Industrie 4.0  

siemens.com/future-of-manufacturing 

Totally Integrated Automation (TIA) 

siemens.com/tia 

TIA Portal 

siemens.com/tia-portal 

SIMATIC Controller 

siemens.com/controller 

SIMATIC Technical Documentation  

siemens.com/simatic-docu 

Industry Online Support 

support.industry.siemens.com 

Industry Mall catalog and ordering system  

mall.industry.siemens.com 

 

 

 

Siemens  

Digital Industries, FA  

P.O. Box 4848 

90026 Nuremberg 

Germany 
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